
How to crop a viewport on a sheet in Revit?
(Step by step)

Description

Are you working with Autodesk Revit and looking to enhance your skills in creating precise and visually
appealing drawings? One essential task is cropping viewports on sheets to focus on specific areas of
interest. Understanding how to crop a viewport in Revit can greatly improve the clarity and
effectiveness of your design documentation. In this comprehensive guide, we will walk you through the
process of cropping a viewport on a sheet in Revit, providing step-by-step instructions and valuable
tips to optimize your workflow.

Key Takeaways

Viewports in Revit act as windows into the virtual building model, allowing you to display and
control the visibility of various views on a sheet.
Cropping a viewport allows you to focus on specific areas, emphasizing key details and
improving clarity.
To crop a viewport, select it, activate the cropping mode, adjust the crop boundary, and finish the
crop to apply the changes.
Maintain consistent scale, leverage detail views, and revisit and adjust cropping as needed for
efficient use of viewport cropping in Revit.

How to Crop a Viewport on a Sheet in Revit

Getting Started with Viewports
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Before we dive into the cropping process, let’s start by understanding what viewports are in Revit.
Viewports allow you to display and control the visibility of 3D views, plan views, and other types of
views on a sheet. They act as windows into the virtual building model, helping you present the desired
information efficiently.

In Revit, you can add viewports to a sheet by using the “View” tab on the ribbon. By default, the
viewports are created with an uncropped rectangular boundary, displaying the entire view on the sheet.
However, cropping a viewport allows you to focus on specific areas, improving clarity and emphasizing
the important details.

Cropping a Viewport Step by Step

To crop a viewport on a sheet in Revit, follow these simple steps:

1. Open the sheet where you want to crop a viewport.
2. Select the viewport you wish to crop by clicking on it.
3. Once the viewport is selected, navigate to the “Modify | Viewports” panel on the ribbon.
4. Click on the “Crop” button to activate the cropping mode for the selected viewport.
5. Revit will display the crop boundary handles around the viewport. Drag these handles to adjust

the cropping boundary as desired.
6. Fine-tune the crop by using the grip handles on the boundary to further refine the viewport’s area.
7. To exit the cropping mode, click the “Finish Crop” button located on the ribbon.
8. Your viewport is now cropped, and the focus will be on the defined area.

It’s important to note that cropping a viewport in Revit doesn’t affect the actual view itself. It only
changes the visible portion of the view within the selected viewport on the sheet.

Tips for Efficiently Cropping Viewports

To make the most out of your viewport cropping in Revit, consider the following tips:

1. Maintain a consistent scale: Ensure that the scale of the view within the cropped viewport
remains consistent with the other views on the sheet. Inconsistent scales can lead to confusion
and misinterpretation of the design intent.

2. Use the crop region for emphasis: By cropping a viewport strategically, you can highlight
specific design elements or key areas of the building model. This helps convey information more
effectively and improves the overall clarity of your drawings.

3. Leverage detail views: If you need to display a highly detailed area within a larger view,
consider using detail views. Detail views allow you to zoom in on specific elements without
affecting the scale of the main view.

4. Revisit and adjust cropping if needed: As your design progresses, you may need to modify the
crop boundary to accommodate changes or to provide additional context. Always review your
cropped viewports and make adjustments when necessary.
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FAQ: How to crop a viewport on a sheet in Revit?

1. How do I edit a viewport line?

To edit a viewport line in Revit, follow these steps:

1. Select the viewport that contains the line you want to edit.
2. Go to the “Modify | Viewports” panel on the ribbon and click on the “Edit Crop Regions” button.
3. Revit will display the crop boundary handles around the viewport. Adjust the boundary handles to

modify the viewport line as desired.
4. You can also use additional tools such as the “Trim” or “Extend” commands to refine the line

further.
5. Once you are satisfied with the changes, click the “Finish Crop” button to apply the modifications

to the viewport.

2. How do I change Page Setup in Revit?

To change the Page Setup in Revit, follow these steps:

1. Open the sheet for which you want to change the Page Setup.
2. Right-click on the sheet and select “Page Setup” from the context menu.
3. In the Page Setup dialog box, you can modify various settings such as the sheet size, orientation,

margins, and print settings.
4. Adjust the desired settings according to your requirements.
5. Click “OK” to apply the changes to the Page Setup of the sheet.

3. How do you zoom in a viewport in Revit?

To zoom in a viewport in Revit, you can use either of the following methods:

Method 1: Double-click on the viewport to activate the view within the viewport. Use the standard
zoom tools, such as the Zoom In tool or the Zoom Extents tool, to adjust the view to the desired
zoom level.
Method 2: Select the viewport and go to the “Modify | Viewports” panel on the ribbon. Click on the
“Zoom to Fit” button to automatically adjust the view within the viewport to fit its boundaries.

4. How do I edit crop view in Revit?

To edit the crop view in Revit, follow these steps:

1. Select the viewport that contains the crop view you want to edit.
2. Go to the “Modify | Viewports” panel on the ribbon and click on the “Edit Crop Regions” button.
3. Revit will display the crop boundary handles around the viewport. Drag these handles to adjust
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the crop region as desired.
4. You can also use the grip handles on the boundary to fine-tune the crop further.
5. Once you are satisfied with the modifications, click the “Finish Crop” button to apply the changes.

5. How do you Uncrop a view in Revit?

To uncrop a view in Revit and restore the full view within a viewport, follow these steps:

1. Select the viewport that you want to uncrop.
2. Go to the “Modify | Viewports” panel on the ribbon and click on the “Edit Crop Regions” button.
3. Revit will display the crop boundary handles around the viewport.
4. Drag the crop boundary handles outward to expand the crop region beyond the current

boundaries.
5. Once you have extended the crop region to cover the entire view, click the “Finish Crop” button to

remove the crop and restore the full view within the viewport.

Remember, uncropping a view in Revit will display the entire view within the viewport and remove any
previously defined crop boundaries.

6. Can you crop a raster image in Revit?

No, Revit does not have native tools to crop raster images directly. However, you can use image
editing software such as Adobe Photoshop or GIMP to crop the raster image before importing it into
Revit. Once you have cropped the image, save it as a new file and then insert it into your Revit project.

In Revit, you can resize and reposition the imported image to achieve the desired cropping effect
indirectly. By adjusting the size and location of the image within the viewport, you can control which
portion of the image is visible.

7. How do I crop a viewport in sheet?

To crop a viewport in a sheet in Revit, follow the steps outlined in our earlier guide. Select the desired
viewport on the sheet, activate the cropping mode, adjust the crop boundary handles to define the
desired crop region, and then finish the crop to apply the changes. This process allows you to focus on
specific areas within the viewport and tailor the presentation of information on the sheet.

8. How do you crop a drawing on a sheet in Revit?

Cropping a drawing on a sheet in Revit follows the same procedure as cropping a viewport. By
selecting the desired viewport that contains the drawing on the sheet, you can activate the cropping
mode, adjust the crop boundary handles to define the desired crop region, and then finish the crop to
apply the changes. This way, you can crop the drawing within the viewport to highlight specific
elements or details on the sheet.
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9. How do you cut a section in Revit?

To cut a section in Revit, you need to create a section view of the desired location. Follow these steps:

1. Navigate to the desired view where you want to cut the section.
2. On the “View” tab, click on the “Section” tool.
3. Define the start and end points of the section line by clicking on the desired locations in the view.
4. Revit will generate a new section view based on the defined line.
5. You can further adjust the properties and settings of the section view, such as the depth, scale,

and visibility of elements.
6. Once you have customized the section view to your liking, place it on a sheet if needed.

10. How do you shorten a viewport in Revit?

To shorten a viewport in Revit, you can adjust the crop region of the viewport. Follow these steps:

1. Select the desired viewport.
2. Activate the cropping mode by clicking on the “Crop” button in the “Modify | Viewports” panel.
3. Drag the crop boundary handles inward to shorten the viewport.
4. Use the grip handles on the boundary to further refine the shortened area, if necessary.
5. Finish the crop by clicking the “Finish Crop” button to apply the changes.

By shortening the crop region, you effectively reduce the visible area of the viewport and focus on the
specific content within it.

11. How do you make a viewport title smaller in Revit?

In Revit, you can adjust the size of the viewport title by modifying the associated view title family.
Follow these steps:

1. Open the sheet containing the viewport with the title you want to resize.
2. Select the viewport, and on the “Properties” palette, locate the “View Title” parameter.
3. Click the button next to the “View Title” parameter to open the view title family for editing.
4. Within the view title family editor, modify the size and appearance of the title text as desired.
5. Save the changes to the view title family, and the viewport title will reflect the updated size.

By customizing the view title family, you can control the font, size, and other properties of the viewport
title to make it smaller or larger to suit your specific needs.

12. How do you remove a scale from a viewport in Revit?

To remove the scale display from a viewport in Revit, follow these steps:

1. Select the viewport from which you want to remove the scale display.
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2. In the “Properties” palette, locate the “Scale” parameter.
3. Clear the value or set it to “None” to remove the scale display.
4. The viewport will no longer display the scale information.

Removing the scale display is useful in situations where you want to emphasize the content within the
viewport without the distraction of the scale information.

13. How do you crop a viewport in AutoCAD?

To crop a viewport in AutoCAD, follow these steps:

1. Activate the layout that contains the viewport you want to crop.
2. Double-click inside the viewport to enter Model Space.
3. Use the “Zoom” and “Pan” commands to position the view as desired.
4. Type “VPORTS” on the command line to access the “Viewports” dialog box.
5. Select the viewport you want to crop and click on the “Modify” button.
6. In the “Viewport Clipping” section, choose “Polygonal” or “Rectangular” for the clipping boundary

type.
7. Specify the points or corners of the boundary to crop the viewport.
8. Exit the viewport by double-clicking outside of it.
9. The viewport will now be cropped based on the defined boundary.

AutoCAD offers various options for cropping viewports, allowing you to customize the visibility of the
content within the viewport.

14. How do I change the viewport layer?

To change the layer of a viewport in Revit, follow these steps:

1. Select the desired viewport.
2. In the “Properties” palette, locate the “View Reference” parameter.
3. Click on the button next to the “View Reference” parameter to open the “Edit Type” dialog box.
4. In the “Edit Type” dialog box, you can change the “Layer” parameter to the desired layer.
5. Select the new layer from the drop-down list or create a new layer if needed.
6. Click “OK” to apply the changes.

Changing the viewport layer allows you to control the visibility and organization of the viewport within
the Revit project.

15. How do you control layers in viewports?

To control the layers in viewports in Revit, follow these steps:

1. Select the desired viewport.
2. In the “Properties” palette, locate the “View Discipline” parameter.
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3. Click on the button next to the “View Discipline” parameter to open the “View Discipline” dialog
box.

4. In the “View Discipline” dialog box, you can specify which discipline-specific layers to show or
hide in the viewport.

5. Use the checkboxes to control the visibility of individual layers within the viewport.
6. Click “OK” to apply the changes.

By adjusting the layer visibility settings, you can control which layers are displayed within the viewport,
allowing you to customize the appearance and content shown in your views.

16. How do you layout a sheet?

To layout a sheet in Revit, follow these steps:

1. Open the desired sheet where you want to create the layout.
2. Go to the “View” tab and click on the “Sheet Composition” button.
3. In the “Sheet Composition” dialog box, you can add views, schedules, and other elements to the

sheet.
4. Use the drag-and-drop functionality to position the views and elements on the sheet.
5. Adjust the size and scale of the views and elements as needed.
6. Arrange the views and elements in a logical and visually appealing manner on the sheet.
7. Use alignment tools and guidelines to ensure proper alignment and spacing.
8. Once you are satisfied with the layout, click “OK” to apply the changes.

By carefully organizing and arranging the views and elements on a sheet, you can create clear and
organized documentation for your project.

17. How do you manage sheets in Revit?

To manage sheets in Revit, follow these steps:

1. Open the “Project Browser” on the left side of the Revit interface.
2. Expand the “Sheets” category to view all the sheets in the project.
3. To create a new sheet, right-click on the “Sheets” category and select “New Sheet.”
4. To duplicate a sheet, right-click on the desired sheet and select “Duplicate View/Sheet.”
5. To delete a sheet, right-click on the sheet and select “Delete.”
6. You can also organize sheets into subsets or folders within the “Project Browser” for better

management.
7. To modify the properties of a sheet, such as the title block or sheet number, select the sheet and

use the “Properties” palette.
8. Use the “Sheet Issues/Revisions” functionality to track changes and revisions on a sheet.

Effectively managing sheets in Revit helps maintain a structured and organized documentation
workflow.
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18. How do I make a sheet template in Revit?

To create a sheet template in Revit, follow these steps:

1. Open a new or existing sheet that you want to use as a template.
2. Customize the sheet with the desired title block, viewports, and other elements.
3. Adjust the sheet properties such as title, sheet number, and any required parameters.
4. Go to the “File” menu and select “Save As.”
5. In the “Save As” dialog box, choose a location to save the template file and provide a name for

the template.
6. From the “Save as type” dropdown, select “Revit Project Template (*.rte)”.
7. Click “Save” to create the sheet template.

By creating sheet templates, you can save time and ensure consistency by reusing predefined layouts,
title blocks, and settings for future projects.

19. How do you pan a viewport?

To pan a viewport in Revit, follow these steps:

1. Activate the desired viewport by double-clicking inside it to enter Model Space.
2. Use the scroll wheel on your mouse to pan the view in the desired direction.
3. Alternatively, you can use the pan command by typing “PAN” on the command line and pressing

Enter. Then, click and drag the view in the desired direction.
4. Continue panning until you achieve the desired view within the viewport.
5. Exit the viewport by double-clicking outside of it.

Panning allows you to navigate and reposition the view within the viewport, helping you focus on
specific areas or details.

20. Can you zoom extents in Revit?

Yes, you can zoom extents in Revit to display the entire model or view within a viewport. To zoom
extents, follow these steps:

1. Activate the desired viewport by double-clicking inside it to enter Model Space.
2. Type “Z” on the keyboard or click on the “Zoom Extents” tool in the navigation toolbar.
3. Revit will automatically adjust the view to fit the entire model or content within the viewport.
4. Exit the viewport by double-clicking outside of it.

Zooming extents allows you to quickly and easily view the entire model or content within a viewport,
ensuring that all elements are visible and properly aligned.

By following these steps and utilizing the features and functionalities of Revit, you can efficiently crop
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viewports, manage sheets, control layers, and navigate within viewports, enhancing your overall
experience and productivity in Revit.

Conclusion

Mastering the art of cropping viewports on sheets in Revit is a valuable skill that can greatly enhance
your drawing presentation and communication of design intent. By following the step-by-step
instructions provided in this guide and utilizing the tips and best practices, you can effectively crop
viewports to highlight key areas and present information with clarity. Remember to maintain
consistency in scale, strategically use cropping for emphasis, and utilize detail views when necessary.

With a thorough understanding of viewport cropping techniques in Revit, you can create professional
and visually appealing drawings that convey your design intent effectively. Embrace the power of
Revit’s viewport capabilities, and unlock new possibilities in showcasing your building information
models.
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